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1 Application / Intended use 

• Inductive measurement of specific conductivity and concentration of fluid media in the 
range of 0…1000 mS / cm 

• For use in hygienic applications of the food, beverage, and pharmaceutical industries 

• Not suitable for use in explosive atmospheres 

• Not suitable for safety-related unit parts (SIL) 

2 Conformity with standards 

The basic safety and health requirements are met through fulfillment of: 

• 2014/30/EU Electromagnetic Compatibility 

• 1935/2004/EU Consumer Goods Ordinance 

• Directive (EU) 10/2011 (Articles in Contact with Food) 

• EN 61000-6-2:2005 (Interference Immunity) 

• EN 61000-6-4:2007 + A1:2011 (Interference Emissions) 

3 Safety instructions 

These safety instructions must be followed to  

• Avoid endangering persons and the environment. 

• Avoid damage to the sensors. 

• Prevent faulty batches during production. 
 
The electrical connections may only be performed by persons with the necessary technical skills 
(e.g. certified electricians or persons with technical training in electrics) and by persons with the 
necessary authorization from the operator. 

The power supply and the control circuit inputs and outputs must be professionally wired. The 
current state-of-the-art of electrical connections must be adhered to. See also section 8 "Wiring 
diagram". 

 

The following details must be noted in particular: 

• Safety instructions 

• Electrical connection data 

1. All persons involved with the setup, commissioning, operation, service, and maintenance 
of the sensor must be suitably qualified. 

2. This operating manual must be followed closely. The operator must ensure that the per-
sonnel has read and fully understood the operating manual. 

3. All work must be performed with utmost care and may only be executed by authorized and 
trained personnel. The applicable national regulations regarding opening and repairing of 
devices must be complied with. 

4. We recommend storing the operating manual near the measuring device in an easily ac-
cessible location. 

5. The sensor must be de-energized prior to alterations and maintenance.  

6. The working area of the operator must offer enough space to minimize the risk of injury. 

7. The technical data specified in the operating manual and on the type label must be noted. 
 
Warranty coverage shall not be granted for any damage that can be attributed to improper execu-
tion of work on the device.  
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4 Special features / advantages 

• The sensor structure is based on a modular device platform which can be tailored to re-

quirements and is easy to exchange if faulty 

• Wear-free, inductive measurement procedure  

• In contrast to conductive measurement procedures, there are no problems due to elec-

trode deterioration or polarization. 

• Hygienic design with Negele weld-in sleeve 

• Individual setting/programming via PC or User Interface 

• Two configurable LEDs on the display unit 

5 Options / Accessories 

• User Interface with small or large display (retrofittable) 

• Programming adapter MPI-200 (PC-based) 

• Tool for detaching the signal module 

• Pre-assembled PVC cables 

6 Installation and Connection 

6.1 Mechanical installation 

 

Mechanical connection / installation notes 

• The device must be installed such that the submersible body is fully surrounded by 

the medium and no air bubbles can form in the sensor area. It therefore is advisable 

to install the device in rising pipes. 

 

 
 

• The device must be aligned such that the lettering "FLOW" is at the bottom of the 

device in the direction of flow. 

• Very strong vibrations can lead to false measurements (e.g. if installed near a 

pump). 

• Use the Negele CLEANadapt system to ensure that the measuring point functions 

properly. 

• When installing the device, adhere to the maximum tightening torque of 20 Nm. 

• To correctly install CLEANadapt weld-in sleeves, use a suitable welding mandrel. 

Follow the weld-in and installation instructions in the CLEANadapt product infor-

mation. 
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6.2 Requirements for hygienic installation 

 

Recommended dimensions for hygienic installation 

 

Tri-Clamp: T < (D-d) 

Recommended mounting positions 

 

 

 

ILM-4 in vertical pipe ILM-4 in horizontal pipe 

Conditions for hygienic installation according 3A and EHEDG 

• The ILM-4 / ITM-4R is designed for CIP/SIP cleaning. The sensor can withstand a 

maximum of 150 °C / 60 min. 

• The mounting position must guarantee self-draining properties. 

• The mounting position and gasket need to follow the actual 3A or EHEDG stand-

ards and guidelines. 

• When using Tri-Clamp process connections, observe the requirements of the cur-

rent 3A and EHEDG regulations regarding installation position, process connec-

tions and approved seals. 
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Not permitted mounting positions 

  

Installation from top or from bottom should be avoided.  

This can lead to incorrect measurement due to accumulation of air or deposits. 

 

Disregarded flow direction 

 

The device should be aligned so that the "FLOW" label on the bottom of the de-

vice in the direction of flow. 

The ILM-4 inductive conductivity meter is set to operate without requiring special adapta-

tions. In isolated instances, some parameters may need to be adjusted. The parameterization 

may be changed using the PC-based MPI-200 programming adapter or the User Interface di-

rectly on the sensor. This can be performed either directly on location or in the office in a dry 

simulation. 
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The sensor is delivered with the following default settings: 

Analog Output 1 (X45 on terminals 4 and 5) 
conductivity 1 with measurement range 0…200 mS/cm 

Analog Output 2 (X67 on terminals 6 and 7)  
temperature with measurement range 0…150 °C 

The parameter list accompanying the sensor contains the sensor settings for output 1 (terminals 4 
and 5) under X45a and for output 2 (terminals 6 and 7) under X67. 

The sensor can be parameterized either via the PC-based MPI-200 programming adapter, IO-link  
or directly on the sensor using the User Interface. 

The ILM-4 inductive conductivity meter features a modular design with a “tree structure”, which 
can be tailored to meet requirements and can be easily exchanged in the event of a fault.  

This tree structure is also used by the MPI-200 programming adapter software for the PC and the 
User Interface in the sensor. The software is subdivided into Display, Electronics (signal inter-
face) and Sensor (conductivity measurement). 

 

Sensor (conductivity measurement): Up to two analog outputs of the sensor for conductivity, con-
centration and temperature can be freely configured. 

Conductivity: Two different conductivities can be set here, independently of one another. The upper 
range limit can be freely selected. In addition, the customer can freely adjust temperature compen-
sation and damping.  

Electronics 

Sensor 

Display 

Settings: 

- Signal selection for the 4…20 mA signal 
- Setpoint for 4 or 20 mA signal 
- Warning signal “No media” and “Out of range” 
- Fault signal “Device error” and “Underflow / over-

flow” 
- Signal limitation for underrange / overrange 
- Signal simulation 
- Configuration of LEDs 

Settings: 

- Temperature compensation, damping 

and upper range limit of conductivi-

ties 1 and 2.  

- Temperature compensation, damping, 

medium concentration range and up-

per range limit of concentration 

- Temperature unit and response time 
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Concentration: Two predefined ranges for common CIP media (NaOH or HNO3) are available for se-
lection. In addition, there is the possibility of entering up to 8 customized media specific points 
(each for conductivity and concentration). A self-defined range is entered by specifying at least 2 
points with values > 0. This customized entry of support points is only possible in the “Setup” level 
or higher. The temperature compensation, damping and upper range limit can also be set. 

Temperature: Output of the medium temperature measured at the tip of the PEEK part on the sensor. 
The temperature unit and response time can be adjusted here. 

 
 
The table below shows the conductivity sensor settings by authorization level: 

 

Parameter Settings in the "Ad-
justment" level 

Settings in the 
"Setup" level 

Adjustable range 

Conductivity measurement   

Conductivity 1    

 Temperature Com-
pensation 

Temperature Com-
pensation 

Freely adjustable from 
0…100%/K 

  Damping 1 Selectable: inactive, 2.5 s, 5 s, 
10 s, 20 s 

 Upper Range Value Upper Range Value Freely adjustable from 
0.5…1000 mS/cm (in increments 
of 0.5) 

Concentration C    

 Temperature Com-
pensation 

Temperature Com-
pensation 

Freely adjustable from 
0…100%/K 

  Damping C Selectable: inactive, 2.5 s, 5 s, 
10 s, 20 s 

 Media Concentr. 
Range 

Media Concentr. 
Range 

NaOH 0…10%, HNO3 0…20% or 
customer-specific points (begin-
ning with "Setup" level) 

 Upper Range Value Upper Range Value Freely adjustable from 1…100% 

  (+) Customer-specific 
points, concentration 

Up to 8 support points for con-
ductivity and concentration 

Conductivity 2    

 Temperature Com-
pensation 

Temperature Com-
pensation 

Freely adjustable from 
0…100%/K 

  Damping 2 Selectable: inactive, 2.5 s, 5 s, 
10 s, 20 s 

 Upper Range Value Upper Range Value Freely adjustable from 
0.5…1000 mS/cm (in increments 
of 0.5) 

Temperature    

  Unit Temperature °C or °F 

  Response Time Normal or rapid 
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Electronics (Signaling interface): 

• Signal selection for the 4…20 mA signal: Selection between conductivity 1 or 2, concentration 
and temperature 

• Set value for 4 or 20 mA signal: By default, the lower range limit is used for the 4 mA signal 
and the upper range limit for the 20 mA signal. This can be adjusted as necessary. 

• "No Media" warning signal: Current loop signal when the sensor is not immersed in a medium 
→ dry running. 

• "Outside Spec." warning signal: Current loop signal if an operating state is outside of the spec-
ified range. The measurement accuracy can no longer be guaranteed. 

• "Global Failure" error signal: Current loop signal if a malfunction occurs, for example if the 
device fails. 

• Signal limit for under range and over range: Lower or upper limit of the current loop signal 
that is still valid and linear when output below 4 mA or above 20 mA. 

• "Underflow/overflow" error signal: Current loop signal is below or above the under range or 
over range limit. 

• Signaling Simulation: Simulates the current loop signal, where the entered parameter value 
briefly replaces the source value. 

• LED configuration: These two LEDs can be configured as required. The procedure is described 
in section 6.3. 

A list of the parameters set in the conductivity sensor is included with the delivery. These param-
eter values, as well as those changed by the users themselves, can be printed out using the MPI-
200 programming adapter via File → Parameter Data → Print and can also be exported as a file 
to the PC (via File → Parameter Data → Export Data File (*.xml)). 

When making the settings, note the help texts in the MPI software for each parameter. They 
provide useful information on changing the selected parameter. 

6.3 Settings using the MPI-200 programming adapter 

The MPI-200 programming adapter is connected to the ILM-4 conductivity meter via the external 
MPI-200-F adapter piece. It must be ensured that the ILM-4 conductivity meter is permanently con-
nected to the supply voltage while the parameters are being set. 

 

Connection plug for the MPI-200-F 

adapter as an intermediate plug be-

tween the ILM-4 electronics and the 

MPI-200 connection 3 (see the next fig-

ure). 

3 

1: not needed 

2: USB port for connecting to a PC 

3: Connection cable to adapter for ILM-4 

Connection of the MPI-200 programming adapter 

1 

2 3 
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After the sensor is connected to the PC and the user software is opened, the following window ap-
pears: 

 
 

1. Information on the current process value 
2. Buttons for changing the parameter setting 
3. Information on the current source value 
4. Adjustable PC parameters 
5. Adjustable sensor parameters 

 
Clicking on the + in the menu opens a submenu 
in which parameters can be adjusted.  
 

 
Note:  
For further settings, please see also the description in the MPI-200 product information. 

To set or change parameters directly in the sensor (see section 6.2 "Settings using the Simple User 

Interface"), you need the ID codes contained in the table below. This table only lists the most im-

portant ID codes.  

Further ID codes can be found in the user software. To view these, right-click on "Info" by the pa-

rameter name. An info box appears with the respective ID (see graphic below): 

Because the search number must have 6 digits, an additional digit is always added in front of the 

five-digit ID (30034 in the graphic above). This digit depends on the node as follows: 

4 for changes to the display 

3 for changes to the signal interface 

0 for changes to the conductivity measurement 

Because the signal selection is in the single interface node, the ID code for the "Signal selection" 

example above is: 330034. 

A list of all ID codes can be printed out via the PC user interface. To do so, click on File → Parameter 

Data → Print to open the corresponding window and print out the complete list of ID codes. 

  

5. 

1. 

2. 

3. 

4. 
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List of important ID codes: 

 
 

Parameter /  
parameter name 

Access / 
setup mode  
(set before 
change is 

made) 

 
 

Search ID-
number 

 
 

Node /  
module 

 
 

Value name 

Display     

Contrast User Interface 2 Setup 451020 4 Display (#) 

Backlight 2 Setup 451030 4 Display (#) 

Screensaver delay time 2 Setup 451050 4 Display (#) 

Signaling interface     

Current Loop Signal     

Signal Selection 2 Setup 330031 3 Signal Int X45a current loop signal 

4-mA Setpoint 2 Setup 330111 3 Signal Int X45a current loop signal 

20-mA Setpoint 2 Setup 330191 3 Signal Int X45a current loop signal 

Underrange Limit 2 Setup 330141 3 Signal Int X45a current loop signal 

Overrange Limit 2 Setup 330211 3 Signal Int X45a current loop signal 

LED 1 digital output     

Signal Selection 2 Setup 330034 3 Signal Int LED 1 digital output 

Warn-S: no Media 2 Setup 331191 3 Signal Int LED 1 digital output 

Warn-S: Outside Spec. 2 Setup 331201 3 Signal Int LED 1 digital output 

Fehler-S: Global Failure 2 Setup 331231 3 Signal Int LED 1 digital output 

Signal-Auswahl 2 Setup 330035 3 Signal Int LED 2 digital output 

LED 2 Digital Output     

Signal Selection 2 Setup 330035 3 Signal Int LED 2 digital output 

Warn-S: no Media 2 Setup 331192 3 Signal Int LED 2 digital output 

Warn-S: Outside Spec. 2 Setup 331202 3 Signal Int LED 2 digital output 

Fehler-S: Global Failure 2 Setup 331232 3 Signal Int LED 2 digital output 

Conductivity Measurement     

Unit of Temperature Comp 2 Setup 013021 0 Measure (#) 

Conductivity 1     

Temp. Compensation 1 2 Setup 013031 0 Measure Conductivity 1 

Damping 1 2 Setup 013041 0 Measure Conductivity 1 

Upper Range Value 1 2 Setup 013091 0 Measure Conductivity 1 

Concentration     

Temp. Compensation C 2 Setup 013032 0 Measure Concentration C 

Damping C 2 Setup 013042 0 Measure Concentration C 

Media Concentr. Range 2 Setup 013061 0 Measure Concentration C 

Upper Range Value C 2 Setup 013092 0 Measure Concentration C 

Conductivity 2     

Temp. Compensation 2 2 Setup 013033 0 Measure Conductivity 2 

Damping 2 2 Setup 013043 0 Measure Conductivity 2 

Upper Range Value 2 2 Setup 013093 0 Measure Conductivity 2 

Temperature     

Unit Temperature 2 Setup 013144 0 Measure Temperature 

Response Time 2 Setup 013145 0 Measure Temperature 
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6.4 Settings using the User Interface 
 

The software structure of the User Interface is like the structure of the PC version. 

The system is operated using two control buttons to the left and right of the display.  These two 
buttons can be used to navigate through the tree structure of the User Interface to change param-
eters. The button functions are as follows: 

 

Note:  

The digits 1), 2) and 3) shown in the graphic below refer to the programming example below.  

1) Briefly press the right button. 

2) Press and hold the right button, select the required mode (e.g. Setup) and node (e.g. Signalint), 
scroll through the menu using the right/left buttons and confirm the selection by pressing and 
holding the right button. 

3) Press and hold the right button and then enter the ID number from right to left. Proceed as 
follows: 

a.) Select the desired position (navigation with the right/left buttons, press the left button: 
Change the position to the left, press the right button, change the position to the right).  

b.) At the desired position, press and hold the right button until the field becomes gray. Then 
enter the numerical value using the right / left buttons and confirm by pressing and hold-
ing the right button until the gray area disappears. Then enter the next digit . 

c.) After all digits have been entered, move all the way to the left with the left button until the 
field become gray. 

Then press and hold the right button. The system jumps to the selected parameter, which 
can now be entered or changed in the same manner. Start by pressing and holding the 
right button. 

For some system-related parameters, you are asked to confirm that you really wish to 
make the change. Do this by pressing the left or right button. 

▪ Press the right button to change the parameter or save the change. 

▪ Press the left button to leave the setting without making a change. 

 

 

 

 

 

 

 

 

 

 

 

Button Press briefly Press and hold

R Jump to next node, parameter Edit a node, parameter

L Jump back to previous node, parameter Leave editing mode without saving, return to next higher level 

R/L Scroll up and down

R and L 

together

Press both buttons for 10 seconds: the menu jumps back to 

the beginning (attention: this is not a reset)

R right

L left
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  Menu Structure 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calibr. Calibr. Calibr. Calibr.

Display

X67 I-Out

X45b 20mA

X67 4mA

X67 20mA

ID-Search

Setup

Sensor

Display

Digital-In

Conducty 2

ID Search ID Search ID Search

Unit Tcomp Sensor

Menu

QuickSetup QuickSetup QuickSetup

LED2 D-Out

Set Displ.

LED1 D-Out

Sensor

Quick Setup Setup

TempComp 1 Display

TempComp C

Range Cd C

Range Cd 2

Language

Contrast

X45b I-Out

MediaRange

Menu Menu

ID Search

QuickSetup

Menu

TempComp 2

Range Cd 1

ILM-4

000000

Setup Setup Setup Setup

Temperatur

X45a I-Out

Set Sens.

Conducty 1

Concentr C

Menu

QuickSetup

Setup

ID Search

Calibr.

OffsetCd 2

Slope Cd 1

Slope Cd C

Slope Cd 2

T-Offset

Calibration

OffsetCd 1

Offset Cd C

X45a 4mA

X45a 20mA

X45b 4mA

R

R l. R l.

R

R l.

R R

R l.

R l.

R

R l.

Calibr. Calibr. Calibr. Calibr.

Display

X67 I-Out

X45b 20mA

X67 4mA

X67 20mA

ID-Search

Setup

Sensor

Display

Digital-In

Conducty 2

ID Search ID Search ID Search

Unit Tcomp Sensor

Menu

QuickSetup QuickSetup QuickSetup

LED2 D-Out

Set Displ.

LED1 D-Out

Sensor

Quick Setup Setup

TempComp 1 Display

TempComp C

Range Cd C

Range Cd 2

Language

Contrast

X45b I-Out

MediaRange

Menu Menu

ID Search

QuickSetup

Menu

TempComp 2

Range Cd 1

ILM-4

000000

Setup Setup Setup Setup

Temperatur

X45a I-Out

Set Sens.

Conducty 1

Concentr C

Menu

QuickSetup

Setup

ID Search

Calibr.

OffsetCd 2

Slope Cd 1

Slope Cd C

Slope Cd 2

T-Offset

Calibration

OffsetCd 1

Offset Cd C

X45a 4mA

X45a 20mA

X45b 4mA

R

R l. R l.

R

R l.

R R

R l.

R l.

R

R l.

R  : Right button 
R l. : Right button (long) 
L : Left button 
L l. : Left button (long) 
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6.4.1 Screen display 

After the sensor parameters have been adapted/changed, or after the sensor is switched on and 

no change is made, the sensor shows the current measurement value. By pressing the right button, 

different measurement values will be shown. After pressing the left button long, the default meas-

urement will be displayed. 

 

 

 

 

 

 

 

 

 

 
 

To leave the display mode and create settings on the sensor, press one of the two buttons on the 

left and right next to the display. The sensor then displays the start page, from where the settings 

can be created. 

6.4.2 LED Configuration 

The display unit features two LEDs that can be individually configured. These can be used to visu-

ally indicate faults directly on-site. The LED to the left of the display is LED 1 while the one to the 

right is LED 2. 

The following options can be selected when setting the LEDs: 

• Signal Selection: The following signals can be selected: conductivity 1 and 2, temperature 

and concentration. 

• Output function, direction of action, switch point entry method, switch point, hysteresis  

• Switch ON Delay, Switch OFF Delay: The digital output is switched on or off with the delay 

set here. Values can be set between 0...30 s. 

• Warn-S: no Media, Warn-S: Outside Spec., Err-Sig: Underflow, Err-Sig: Overflow, Err-Sig: 

Global Failure: The effect of each parameter on the LED display can be set. The following 

can be selected: "No Effect on Output", Output Fast Blinking" (0.4 s interval), "Output Slowly 

Blinking" (1 s interval), "Output ON" (LED on continuously) and "Output OFF". "Output" refers 

to the LED here. 

• Signaling Simulation: the entered parameter value briefly replaces the source value. The 

following situations can be simulated: "Output OFF", "Output ON", "Output Slowly Blinking" 

and "Output flashes rapidly". "Output" refers to the LED here. 

The conductivity sensor is delivered with the following factory settings for the LEDs:  

• LED 1 (left LED) 
Err-Sig: Overflow: The LED flashes every second if the sensor registers an overrange error. If 
the sensor is in a normal state, this LED is off. 

• LED 2 (right LED)  
Power ON Signal – Err-Sig: Global Failure: LED lights up continuously in normal mode as 
long as the device is supplied with power. If a device failure occurs, this LED flashes rapidly 
(approx. 0.4 s interval) 

 

Node / module 

Value name 

Measured value cur-
rently being output 
at the current output 

Parameter / parame-

ter name 

Value currently set for this parameter 
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6.5 Examples of sensor settings 

Several examples of settings that can be created on the Simple User Interface or on the user inter-

face of the PC follow (setting of a customized conductivity 1, the associated temperature coeffi-

cient and the concentration curve). 

The device is operated using two operating buttons on the left and right next to the display. When 

the sensor is in display mode, i.e. the display is running through the process values, one of the two 

buttons must be pressed to reach the start page. The buttons function as follows:  

6.5.1 Setting of customer-specific concentration curve via MPI-200 software 

After the PC software is started, a customer-specific curve for the concentration can be entered via 

the following node: Conductivity Measurement → Concentration C → (+). Values need to be en-

tered for at least 2 X and Y points. Up to 8 support points for X and the associated Y values can be 

entered to establish the relationship between conductivity (X) and concentration (Y). The Y values 

together with the associated X values form coordinates that act as support points for the lineari-

zation curve. If 0 is entered for any of these points, that support point is deactivated. 

X-Point 01 up to X-Point 08 (Conductivity): This parameter is used to define the customer-specific 

measurement range of the conductivity. Values can be entered from 0…1000 mS/cm. 

Y-Point 01 up to Y-Point 08 (Concentration): This parameter is used to define the customer-spe-

cific measurement range of the concentration. Values can be entered from 0...100%. 

  

Node (19)

 press button short

Language press button for long time

English

Display

Button for 

operation
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6.5.2 Example for setting conductivity 1 using the display 

 

Alternatively, to entering the measurement range as described above, the measurement range can 

also be adjusted by entering an ID code.  

To do so, go to “YES” on the ID search page and enter the ID code using the buttons. After the code 

is confirmed, the sensor display shows the menu in which the parameter can be adjusted. 

  

Calibr.

QuickSetup

Setup

ID Search

0 mS/cm

ID: 013091

200.0mS/cm

0200.00

Range Cd 1

TempComp C

TempComp 2

Conducty 1

Quick Setup

TempComp C

TempComp 2

Range Cd 1

Quick Setup

Range Cd 1 xxx °C

Range Cd 1

Conducty 1

0 mS/cm

Conducty 1

 

Range Cd 1

Conducty 1

0 mS/cm

ID: 013091

Range Cd 1

0 mS/cm

ID: 013091

Range Cd 1

ID: 013091

Conducty 1

0 mS/cm

ID: 013091

Range Cd 1

Conducty 1

0 mS/cm

ID: 013091

Conducty 1

Range Cd 1

last step

for all

digits

Repeat the

ID: 013091

0 mS/cm

Menu

0200.0

0200.0

0200.0

0200.0

Save Data?

 

No / Yes

Temperatur

0200.0

ILM-4

Conducty 1

0 mS/cm

R l.

R 

R l.

R

R l.

R/L

R l.

R l.

R

R l.

R l.

R l.

R  : Right button 
R l. : Right button (long) 
L : Left button 
L l. : Left button (long) 
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7 Installation of the „Large User Interface“ (LUI) 

1. Remove the plastic cover (continue with step 4), or remove the puck with the mounted small 
display (continue with step 2) 

2. Remove the small display 
3. Install the puck in the sensor head 
4. Mount large display 

Hot-plug function: The large display can be installed while the sensor is energized, but this re-

quires the usual precautionary measures when working with electronic components.  

If the display is being installed while energized, it is necessary to press both buttons simultane-

ously for > 10 s after the display is installed to activate the display. 

7.1 Retrofitting the display if a display was not yet installed 

 

 

 

After removing the plastic cover, the large display can be inserted in the head of the sensor. The 

tabs (Fig. 2) must be inserted in the appropriate openings on the puck (Fig. 1). Then the display can 

be easily pressed onto the puck. No wiring is required. 

Note: After the Large User Interface is mounted, the sensor can only be operated on this display 

since the display conceals the connector for the MPI-200 adapter. If operating the sensor using the 

programming software is preferred, the display must be removed. Then the connector of the pro-

gramming adapter can be plugged in. 

 

 

   

Fig. 1 Fig. 2 Fig. 3 

 

 

 

Attention: The connector of the programming adapter (Fig. 3) must be connected in the correct 

direction → the green spacer must face the cable exit (M12 connector or PG). 

Remove the plastic cover: To do so, bend the tabs 

slightly inwards with a screwdriver to be able to 

remove the cover easily. 
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7.2 Retrofitting the display if a small display (SUI) was already installed 

First the puck with the mounted display needs to be removed using the puck puller tool (Fig. 4). To do so, 

detach the wires from the cable terminal. Then insert the five arms of the puck puller in the plastic tabs 

of the puck (Fig. 5). 

Push the puck puller all the way into the sensor head and push 

the disk as far as possible toward the sensor head so that the 

arms of the puck puller firmly grasp the puck.  

Pull the puck with the display out of the sensor housing and 

pull the small display off the puck.  

 

Now the puck without the display can be properly positioned and installed back in the sensor head 

and the wiring can be reconnected to the cable terminal. Then the large display can be mounted → 

see "Retrofitting the display if a display was not yet installed". 

7.3 Using the large display 

The large display (LUI) is operated in the same way as the small display (SUI). It is operated using two 

operating buttons below the display: 

After the sensor is started, the screen saver appears in which the process values of the sensor are 

displayed one after the other. To reach the start page from here, press one of the two buttons briefly. 

Further information on operating the display can be found in the quick start manual and in the oper-

ating manual. 

  

Fig. 4 
Fig. 5 
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8 Dimensions 

For all process connections, the conductivity sensor can be ordered with a submersion length of 
L20 (20 mm) or L50 (50 mm). 
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9 Electrical Connection Analog Signal Modules 

9.1 Terminal Block of A5x/A6x Series 

 

 

 

 

X A52 A53 A62 A63 

X1 Power Supply + Power Supply + 

X2 Power Supply - Power Supply - 

X3 Not assigned Digital Input X3 Not assigned Digital Input X3 

X4 Analog Output X45 + Analog Output X45 + 

X5 Analog Output X45 - Analog Output X45 - 

X6 Relay 67 Analog Output X67 + 

X7 Relay 67 Analog Output X67 - 

 

 

9.2 Terminal Block of A4x Series 

 

X A42 

X1 Power Supply + 

X2 Power Supply - 

X3 Not assigned 

X4 Analog Output X45 + 

X5 Analog Output X45 - 
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9.3 M12 connector cables color 

 

M12 Connector Pin Standard Color Anderson Color 

 

1 Brown Red 

2 White Black 

3 Blue Green 

4 Black  

5 Grey White 

9.4 M12 connectors for A6x/A5x series 

 

Electrical connection „N“ 

M12 connector Signal Module 

Connector Pin A52 A53 A62 A63 X 

 

1 Analog Output X45 + Analog Output X45 + X4 

2 Relay X67 Analog Output X67 + X6 

3 Relay X67 Analog Output X67 - X7 

4 Analog Output X45 - Analog Output X45 - X5 

 

1 Power Supply + Power Supply + X1 

2 Not assigned Not assigned - 

3 Not assigned Not assigned - 

4 Power Supply - Power Supply - X2 

5 Not assigned Digital Input X3 Not assigned Digital Input X3 X3 

 

 

Electrical connection „A“ 

M12 connector Signal Module 

Connector Pin A52 A53 A62 A63 X 

 

1 Analog Output X45 - Analog Output X45 - X5 

2 Analog Output X45 + Analog Output X45 + X4 

3 Power Supply + Power Supply + X1 

4 Power Supply - Power Supply - X2 

 

1 Relay X67 Analog Output X67 + X6 

2 Not assigned Not assigned - 

3 Not assigned Not assigned - 

4 Relay X67 Analog Output X67 - X7 

5 Not assigned Digital Input X3 Not assigned Digital Input X3 X3 
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9.5 M12 connectors for A4x series 

 

 

 

M12 connector Signal Module A42 

Connector Pin El. Connection „M“ X 

 

1 Power Supply + X1 

2 Analog Output X45 + X4 

3 Analog Output X45 - X5 

4 Power Supply - X2 

 
 
 
 
 
 

M12 connector Signal Module A42 

Connector Pin El. Connection „L“ X 

 

1 Power Supply + X1 

2 Power Supply - X2 

3 Analog Output X45 - X5 

4 Not assigned - 

5 Analog Output X45 + X4 
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10 Electrical Connection Digital Signal Modules 

10.1 Terminal Block of I5x/I6x Series 

 

 

 

X I52 I53 I62 I63 

X1 Power Supply + Power Supply + 

X2 Power Supply - Power Supply - 

X3 IO-Link 
IO-Link /  

Digital Input X3 
IO-Link 

IO-Link / 
Digital Input X3 

X4 Analog Output X45 + Analog Output X45 + 

X5 Analog Output X45 - Analog Output X45 - 

X6 Relay 67 Analog Output X67 + 

X7 Relay 67 Analog Output X67 - 

 

 

10.2 Terminal Block of I4x Series 

 

PIN I42 

X1 Power Supply + 

X2 Power Supply - 

X3 IO-Link 

X4 Analog Output X45 + 

X5 Analog Output X45 - 
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10.3 M12 connector cables color 

 

M12 Connector Pin Standard Color Anderson Color 

 

1 Brown Red 

2 White Black 

3 Blue Green 

4 Black  

5 Grey White 

 

10.4 M12 connectors for I6x/I5x series 

 

Electrical connection „R“ 

M12 connector Signal Module 

Connector Pin A52 A53 A62 A63 X 

 

1 Analog Output X45 + Analog Output X45 + X4 

2 Relay X67 Analog Output X67 + X6 

3 Relay X67 Analog Output X67 - X7 

4 Analog Output X45 - Analog Output X45 - X5 

 

1 Power Supply + Power Supply + X1 

3 Power Supply - Power Supply - X2 

4 IO-Link 
IO-Link /  

Digital Input X3 
IO-Link 

IO-Link /  
Digital Input X3 

X3 
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11 ILM-4 IO-Link Device Identity 

 

 

12 ILM-4 IO-Link Process Data 
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13 Repair and maintenance 

The conductivity sensor described here is maintenance-free. However, if it should become nec-

essary to calibrate the sensor, the offset (zero point) and the span of the sensor can be set in 

the "Calibration " mode (via the software). 

For this purpose, navigate to the following window via the user interface (for example, for con-

ductivity 1): "Conductivity Measurement → Conductivity 1 → Offset Conductivity 1" (for off-

set) or "Conductivity Measurement → Conductivity 1 → Slope Conductivity" (for span).  

For the offset, the set value is added to the calibrated conductivity value set at the factory. For 

the span, the set factor is multiplied with the calibrated conductivity value set at the factory. 

This method can also be applied to concentration, conductivity 2 and temperature (offset only). 

The adjustable ranges are:  

- Offset conductivity: half of the set measurement range, e.g. -50…50 mS / cm in measure-
ment range 0…200 mS / cm 

- Slope Conductivity: 75 %...125 %. 

The setting can also be made via the Simple User Interface directly on the sensor using the ID 

codes 013071 for the zero-point conductivity and 013081 for the conductivity slope. 

We recommend always using a reference solution and a reference device for calibration. 

 

14 Technical data 

Submersion length Product-contacting L20: 20 mm 

L50: 50 mm 

Measurement range The measurement range is 

freely adjustable 

0…0.5 mS/cm to 0…1000 mS/cm in 

half-steps 

Process connection Thread CLEANadapt G1" hygienic 

Tri-Clamp 1.5", 2", 2.5", 3" 

DN 25 (type F) DN 40/50 (type N) 

Process pressure  Max. 16 bar 

Tightening torque  20 Nm (CLEANadapt system) 

Materials Connecting head 

Threaded connector 

Submersible body 

 

Plastic cover/sight glass 

Stainless steel 1.4308 

Stainless steel 1.4305 

PEEK (FDA approval:  

21 CFR 177 2415) 

Polycarbonate 

Temperature ranges Ambient 

Process 

CIP/SIP 

-10…70 °C 

-10…130 °C 

150 °C max. 60 min 
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Reproducibility of conductivity < 1% of measurement value 

Resolution/measure-

ment range 

< 1 mS / cm 

< 10 mS/cm 

< 100 mS / cm 

< 1000 mS / cm 

0,001 mS / cm 

0,01 mS / cm 

0,1 mS / cm 

1 mS / cm 

Accuracy Slope 

Offset 

+ 2% of measurement value 

+ 20 µS/cm 

Long-term stability  < 0.5% of upper range limit 

Accuracy of temperature 

output 

< 100°C 

100…150°C 

Max. 0.5 °C 

Max. 1.0 °C 

Response time t90  < 100 ms 

Electrical connection Cable gland 

Cable connection 

Supply voltage 

Protection class 

2 x M16 x 1.5 

2 x M12 connector  

18…36 V DC max. 190 mA 

IP 69K 

Output 2 analog outputs / 1 digital 

Input and optional IO-Link 

Configurable, conductivity 1 or 2, 

temperature or concentration 

Weight  850 g 
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